Quick Start to Microsoft Excel 2013

MI Shivute and JP Van Belle
This unit will provide the basic introduction to MS-Excel 2013. The emphasis is on the minimum knowledge required to work productively. The next module will concentrate on more advanced Excel skills.

At the end of this module, you should be able to:

- Explain where spreadsheets can best be used
- Identify the basic parts of a Spreadsheet
- Enter labels, values, formulas and functions into a Spreadsheet
- Construct simple business formulas using arithmetic operators, cell references and summation function.
- Copy cells containing values and formulas.
- Use relative, absolute and mixed cell references
- Change values and evaluate their impact on dependent cells
- Use the formatting commands to change the appearance of a spreadsheet including:
  inserting and deleting rows and columns, formatting numbers (currency, accounting, and percentage), aligning text and numbers, generating borders, patterns, and font colours.
- Save and Print a Spreadsheet
INTRODUCTION TO MS EXCEL 2013

WHAT DOES A SPREADSHEET DO?

Spreadsheets store numbers, formulas and text in a matrix (or table, grid) of rows and columns to provide solutions to quantitative problems. These problems were traditionally tackled with pen, paper and calculator, for example: Preparation of budgets and financial statements

• Mathematical calculations
• Forecasting models
• Pricing and costing models

The main reason why electronic spreadsheets are far superior to their manual counterparts is that the electronic spreadsheet is dynamic. While manual spreadsheets contain text and values, all calculations are done manually using the calculator. Electronic spreadsheets consists of values, text and built in formulas and functions and they are used for capturing, storing, organizing and manipulating data. If the spreadsheet is well designed, when a value is changed in a cell, all the formulas referencing that value will automatically be recalculated. This simple fact is the real reason for the power and popularity of electronic spreadsheets.

A modern spreadsheet package such as Excel does much more than the calculator was ever capable of. Browse briefly through the advanced Excel module to get a taste for the powerful capabilities of Excel, such as interactive data analysis or charting.

SOME IMPORTANT TERMINOLOGY.

• **Spreadsheet**: this is a generic term which can refer to either the document that is created (as embodied in the file which is being stored) as well as the software application which is used to create this document (e.g. MS-Excel).

• **Workbook**: this is Microsoft’s term for the spreadsheet document created by Excel. Each Excel workbook is stored in a separate file and identified by the icon and the `.xlsx` file extension. In these notes, the terms spreadsheet and workbook are used as synonyms. The default name for a new workbook is “Book1”.

Quick Start to MS-Excel 2013
• **Worksheet:** refers to one single page in a workbook. A workbook can consist of only one or several pages. The default name for the first worksheet in a workbook is “Sheet1.”

A worksheet can be visualized as one huge sheet of paper, consisting of a matrix or table in which data can be entered. At any one time, only a small portion of the sheet is visible through your window, but you can move the window around to see different areas of your worksheet. The workbook, then, is equivalent to a stack or bundle of these worksheets, which can be shuffled at but belong logically together and are therefore kept together in the same computer file.
The examples below show some typical spreadsheet applications and their layout: an invoice, a balance sheet, a loan calculator and a chart. Refer also to the exercises at the back of this module for additional examples.

### SOME EXAMPLES

#### Invoice

A sample invoice with details of items purchased, quantities, prices, and total cost.

#### Vehicle Payment Calculator

A calculator for calculating vehicle payments, including fields for purchase price, down payment, trade-in value, interest rate, and length of loan.

#### Balance Sheet

A balance sheet showing current ratio, quick ratio, cash ratio, working capital, and assets and liabilities breakdowns.

<table>
<thead>
<tr>
<th>ASSETS</th>
<th>LIABILITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT ASSETS</td>
<td>CURRENT LIABILITIES</td>
</tr>
<tr>
<td>Cash and cash equivalents</td>
<td>Accounts payable and supplies payable long-term debt</td>
</tr>
<tr>
<td>Short term investments</td>
<td>Accounts payable and supplies payable short-term debt</td>
</tr>
<tr>
<td>Accounts receivable</td>
<td>Notes payable and banknotes payable</td>
</tr>
<tr>
<td>Inventory</td>
<td></td>
</tr>
<tr>
<td>Prepaid rent, insurance, and other current assets</td>
<td>Short-term debt and line of credit</td>
</tr>
</tbody>
</table>

#### Payroll Report

A payroll report showing employee details, hours worked, pay rates, and total earnings.

---

**Quick Start to MS-Excel 2013**
NAVIGATION

Starting Ms Excel 2013

1. Click on the START BUTTON on the taskbar

   ![Start Button]

   Click on Start

2. Click on All PROGRAMS on the START MENU

   ![All Programs]

   Click on Programs

3. Click on Microsoft Office 2013 >> Excel 2013 on the SUB-MENU

Quick Start to MS-Excel 2013
You can either find and click the Excel 2013 shortcut on your desktop or task bar, or Search for Excel 2013 under the search programs and files. You can load an existing Excel document and click on the file button (on your menu bar) followed by the new button and select the blank workbook option.

The following is an example of the screen shot of a typical Excel spreadsheet.
The Excel window has the same window components as any other MS-Office 2013 component. A brief review:

- **The File Tab/Menu bar:** allows access to all Excel functions. For keyboard shortcuts, click or press the `<Alt>`-key followed by the underlined letter of the menu choice which will be displayed below the menu.

- **The Ribbon** provide graphic buttons so that frequently used functions can be accessed by a single click.

**Quick Access Toolbar** There are many toolbars available. By default the toolbar relating to the home menu will be shown. You can see additional toolbars by selecting the appropriate menu option on your menu bar, this will allow you to see all the toolbar relating to the menu.

- **The Formula bar** is specific to Excel and allows the editing of a specific cell entry.
• The **worksheet** area is made up of rows and columns and it shows a portion of the current worksheet.

• The **scrollbars** allow the quick navigation across a particular worksheet. The length of the scrollbar indicates the relative portion of the spreadsheet that is visible in the current worksheet edit area. Drag the solid bar to move fast, click on the empty bar area to move a screen at a time or click on the triangle arrow button to move a row or column at a time.

• The **worksheet tabs** at the bottom of the worksheet allow you to switch between the different worksheets in your book. Click on a tab to switch to the sheet, drag a tab to rearrange its order in the workbook, or right-click the tab to rename, copy or delete the sheet.

  The button allows you create/add a workbook. You can also use the worksheet navigation buttons to move one sheet left / right at a time, or display hidden workbooks by clicking on the three dots next to the navigation buttons.

• The **name box** (to the left of the formula bar) typically indicates your current cell address (or its name) in the spreadsheet. Any data that you type will be entered in the cell indicated by that address. Whenever appropriate it will hold the name of a range or the formula more recently used.

  The **task pane**, is a feature that will appear from time to time depending on the tools you are using. It often appears when you are formatting pictures or working with charts, it provides quick access to commonly used functions depending on the task. However, the Excel task pane is not as useful it is in Word or PowerPoint, and in most case users prefer to see as much of the spreadsheet data as possible. For this module, the use of task pane will be ignored.
The following is a more detailed view of the worksheet edit area.

![Figure 2 Typical Worksheet edit area](image)

The edit area contains the grid of the current spreadsheet. This grid has the following components.

**COLUMNS**

A column has a name, as indicate by letters A, B, C etc. Column D is indicated with slanted lines. A sheet has 16,384 Columns. A column’s main attribute is its width.

**ROWS**

Row names are indicated by numbers: 1, 2, 3, etc. A sheet has far more rows than columns: the last row is 1,048,576. A row’s main attribute is its height.

**CELLS**

The cell is the most basic unit of a spreadsheet: it is the intersection of a column and a row. Its name (within the context of a given worksheet) is therefore the combination of its respective column and row names e.g. D4 or DZ5803. We will see further how cells can be given more natural sounding names such as *Growth Rate*. Note that other spreadsheet software may have different naming conventions, and Excel can adopt one of these e.g. R4C6 to indicate the cell at the intersection of the 4th row and the 6th column.
RANGE

A range is a rectangular selection of cells. It can be any number of columns wide and any number of rows high. The smallest range on a sheet is one single cell, often ranges are just one column wide or one row high, but most ranges are “true” rectangular area. A range is normally named by indicating the cell addresses of two opposite corner cells, separated by a colon. E.g. the range indicated in the example above could be referred to as any of the following: F7:H10 or F10:H7 or H7:F10 or H10:F7. A range can also be given a more natural name.

NAVIGATING AROUND THE WORKSHEET

THE CURRENT CELL

Your cursor position within a worksheet is indicated by what is called the current cell. If you start typing data, the current cell is where the data will be stored. You can check the current cell address by looking in the name box, which is on the far left of the formula bar. Within your sheet edit area, the current cell is indicated by a heavy black border around the cell. Also, the column and row names are highlighted by a darker background colour. This is very useful if you are working on a big monitor and your sheet edit area is very large.

Most of the time, you will be entering or editing data, therefore using the mouse to move the cursor is not always practical. The following keys will help you move the cursor around the current worksheet. If you have typed some data, pressing one of the navigation keys will result

Quick Start to MS-Excel 2013
in the data being inserted in the current cell and then the cursor will move to the next cell as indicated.

<Enter> : will move the cursor one cell down.

<Shift>-<Enter> : will move the cursor one cell up.

<Tab> : will move the cursor one cell to the right.

<Shift>-<Tab> : will move the cursor one cell to the left.

An alternative is to use the cursor (arrow) keys: e.g. pressing the <Up> or <Down> arrow key will enter the data into the current cell and then move the pointer one cell up or down respectively. Similarly, the <Left> and <Right> arrow keys will move you one cell left or right (except when you are in “edit” mode). Also note that pressing <Alt>-<Enter> does not enter the text into the cell but allows you instead to wrap text over several lines within the within

the same cell.

ENTER MODE.

Move your cursor to cell B2 and start typing something (anything). Notice how the typed text appears both in the cell (using the current formatting) and the formula bar. Confusingly, the mouse cursor (the arrow) can be at another cell e.g. A1), but the edit cursor (a vertical bar: |) is either in the current cell or in the formula bar.

When you make another cell your current cell and you start typing, you are in “Enter” mode as indicated on the left of the status bar. In “Enter” mode, the only active editing key is the
<BackSpace>-key, which is the key above the <Enter>-key and usually indicated by means of a back arrow.

When you have finished entering data, you can click the ✓ button on the formula bar to accept and insert your data (or formula) in the cell. Your text cursor will remain in the current cell. Alternatively, you can press one of the keys mentioned above (<Enter> etc.) to indicate that your cell entry is complete and move to an adjacent cell. Clicking the ✗ button will reject the text which you typed in the formula bar and leave the original data, if any, in the current cell. You can also press the <Esc>-key to achieve the same effect.

EDIT MODE

Edit mode allows you to edit the current cell entry without having to re-enter the entire data from the beginning. If you enter a formula with a syntax error, Excel will put you automatically in edit mode. Alternatively, you can switch to edit mode by pressing the <F2> function key. Use the following keys to edit the current cell entry.

- <Left> and <Right>: move the text cursor one character to the left / right.
- <Home> and <End>: move the text cursor to the beginning / end of the cell entry.
- <Ctrl>-<Left> and <Ctrl>-<Right>: move the cursor one word left / right.
- <F2>: ends edit mode again.

You can also use the mouse and click anywhere in the formula bar to edit the text at a particular position in the formula.
Templates are files in Excel that consists of existing information and they are designed to be interesting, compelling, and professional-looking documents. The formatting for templates is complete, you can just customize it to your liking. Examples of templates in Excel 2013: calendars, cards, resumes, invitations, and newsletters. Your Office programs come with several templates already installed.

To insert a template:

- Click File > New

Tip In an Office 2013 program, choose a template from the new start screen.

- Click the template you want to use, and then click Create. A new file opens in the template you've selected.

You can alternatively search for templates under available categories:
Or search for online templates, Go to the templates home page on Office.com.

To select a template you have saved on your computer,

- Click My Templates or Personal, and then choose your template.

You can use the free templates or modify them based on your unique needs.

**TYPES OF DATA**

Note from the example a cell can contain any one of the following types of data elements.

**NUMERIC VALUES.**

A numeric value is a number such as 141 or 5%. All numbers are treated as constants. Any sequence of numbers, optionally containing a leading + or – symbol and decimal point, is treated as a numeric constant. Excel also allows the use of the %-sign in constants.

When working with very large or small numbers, scientists will also use the symbol “E” to multiply a number with a power of 10 e.g. 1.2E+9 is equivalent to 1.2 x 10^9 or 1200000000 (1.2 billion). Similarly 3E-9 is 3 x 10^-9 or 0.000000003 (3 billionths). Note that +3E-9 (a very small positive amount) is not the same as -3E-9 (a very large negative amount e.g. your bank balance when you owe the bank 3 billion!).

Depending on your system configuration, Excel will also accept a specific currency symbol as part of numeric value e.g. entering R3.50 in a South African spreadsheet is actually entered as the value 3.5 with currency formatting whereas $3.50 will be taken as a text value. A PC configured for use by Americans may instead accept the $ symbol (and treat R3.50 as a text value). Using the / or – symbols together with numbers (e.g. 3/5) may cause Excel to treat your input as dates, as discussed in the next unit.

The display format of a number does not affect the value used in subsequent calculations. E.g. 0.05 or 5% or R0.05 or 0.0500000 all mean the same thing when used in subsequent formulas. Often the result of a formula is displayed with no or a small number of decimals but the actual value stored (and used in subsequent calculations) is much more precise. E.g. even though the number 1/3 may be displayed as 0.33333 or 33% on-screen, the actual value used in calculations is really 0.333333333333333 since Excel’s internal number precision is actually 15 digits.
TEXT VALUES

A text value or label is a string of alphanumerical symbols (letters and numbers) such as “Total” or “Cherries”. Generally, text has meaning to the user but is not normally used in numeric calculations. They typically elucidate the values contained in the spreadsheet.

Sometimes, you want to enter a text value which could be interpreted by Excel as a formula or numeric value e.g. an international telephone number such as “+27-21-6501234”, a grade symbol such as “+2” or a regional road name “R3” (with R also being the local currency) are all meant to be text. You can easily force Excel to treat these as text values by preceding them with a <space>, or even better by preceding them with the single quote <’> character.

FORMULAS

The formula provides the intelligence and dynamics to Excel spreadsheets and are discussed in the next section.

ENTERING DATA

BUILDING YOUR FIRST SPREADSHEET

To get familiar with the basic editing keys and formatting options, let us build a very simple spreadsheet. Press the <Ctrl>-<N> shortcut keys or select the New... option from the File menu to start with a new spreadsheet. In Excel 2013, the New Workbook task pane will pop up; select the Blank workbook option.

First click on cell B1 to make it the current cell and type the text “My shop”. Press the <Enter>-key and B2 will become your current cell as indicated by the green border and the darkened row & column names. Press the <Left> arrow key to make A2 your current cell.

Now type in the different products your shop is selling as per example on the right. If you make a mistake, you can correct it by using any of the keys as discussed above. Even if you don’t make any typos, you should experiment with the various cursor keys any-way! When you have entered the last product “Dates”, move to cell B2 and type the three letter abbreviation for the first month of the year for which you will be capturing your sales: “Jan”. Do not press the <Enter>-key but instead click on the Enter button.

Quick Start to MS-Excel 2013
To show off some of the power of Excel, we will now automatically fill in the next 3 months by dragging the current cell handle (the little black square at the bottom right corner) horizontally across to cell E2.

It takes a little practice to do it right. You know that your mouse cursor has reached the handle and is ready for dragging, when it changes from a white cross \( \times \) to a black cross \( + \) shape.

As you drag the handle horizontally across, the names of the next few months should appear in smart tags and when you release the handle Excel will insert (“AutoComplete”) the months Feb to Apr for you.

All that remains now is to complete some sales figures for each of the products and each of the months. Enter the sales amounts as shown in the example.

**MODIFYING CELL CONTENTS**

**Auto Fill**

The Auto fill feature is used to fill cells with data, following a pattern that is based on other cells. These include pattern of text, dates or numeric values. E.g. When you drag a cell with numerical or date data over adjacent cells, Excel tries to determine a pattern and fill it in for you.
Instead of entering the numeric values manually on a worksheet, you can use the Auto Fill feature to automatically determine the pattern and enter numbers in the adjacent cells.

**Flash Fill** - Feature in Excel that is used to automatically enter the data in the format you need it to be. Sometimes you need to enter amounts of repetitive information, such as list of names or dates. Entering such lists manually is daunting. Using flash Fill (a new feature in Excel 2013) saves you a lot of time. To automatically enter your dates in a similar pattern make sure you specify the format for the first cell, and then move your cursor to the adjacent cell then click flash fill on the **Data** menu, under **data tools** category.

The pattern is populated to **B5:B13**.

**SIMPLE CELL FORMATTING**

We can now start working a little on the appearance of our mini-spreadsheet by applying some basic formatting.
Select the range B2:E2 by dragging your cursor from cell B2 to cell E2. There will be a green border around the selected range with all but the starting cell highlighted. We will be using the toolbar buttons on the formatting toolbar for the following simple formatting exercise. Let us increase the **font size** from 10 to 12 points by clicking on the drop-down **font size list** button and selecting 12 from the drop-down list. Note how the row height of row 2 increased automatically to accommodate the taller text.

We also click on the **bold** Toolbar button as well as on the **centre text** button.

Quick formatting can be done from the formatting popup (right–top). Right click on the text you want to format, then select *Calibri* as your **font type**.

To demonstrate how to edit existing text without having to retype the whole text, click on cell B1 to make it the current cell. Note how the text “My shop” appears in the formula bar as well. Click in the white space between “My” and “shop” within the formula bar and insert the word “magnificent” and press `<Enter>`. The text in B1 now reads “My magnificent shop”. Note how text that is longer than the cell width can accommodate, flows over in the next adjacent cell (C1), at least if the latter is empty.
Let us now make the title a bit bolder. First, we will join the cells B1 to E1 together to make them one big cell: this is called merging cells. Select the range B1:E1 (by dragging your cursor from B1 to E1) and click on the **Merge and Center** toolbar button. The result should be as shown below.

The light-grey cell boundary lines between the cells B1 to E1 have disappeared! Excel now treats the range B1:E1 as one single cell, containing the text “My Magnificent Shop”. Incidentally, the cell address for this merged cell is B1. Indeed for any merged range, the cell address will be that of the top left corner (original) cell. And yes, you can merge cells horizontally as well as vertically.

Let us now complete the formatting of the title. Click on the merged cell and change its font to *Arial Black*. Use a 14 point font size. Then click on the **Font Color** toolbar button and set the font colour to *Red*. Click on the **Fill Color** toolbar button and set the cell background to *Yellow*. Finally click on the **Borders** button and select a *Thick Box Border* for the title cell. You should have the result as per below.

Excel also allows you to perform selected font formatting to parts of the contents of a cell. To
illustrate this, select only the word “magnificent” in the formula bar as shown. Now click on the appropriate toolbar buttons to change the font of only the word magnificent back to Arial but make it 18 points large. Also change its colour to green and make it italics. Note that only the relevant few formatting toolbar buttons are available for use – the others, such as (horizontal) cell alignment, are greyed out (or dimmed).

The last formatting we need to do, concerns our sales figures. Highlight/select the range B3:E6 and click on the Currency button. If your Windows has been installed for South African currency, the numbers will now show as Rand values, displayed with two decimal places. We want to get rid of the two decimal places, so click twice on the Decrease Decimal button.

Okay, that is enough formatting for the moment. We will return to more advanced formatting at a later stage. Let us now add some complexity to our spreadsheet by putting in some formulas.
SAVING AND UPDATING WORKBOOKS

Saving your workbook allows you to keep your content up to date and save any changes you made to the document. You can use the keyboard keys to save your workbook, by pressing **Ctrl+S** to save the workbook in the current location (e.g. My documents, desktop or other locations).

You may need to save your workbook for the first time, in a different location, or to create a copy of your workbook in the same or another location. You can do so by:

1. **Click File > Save As**

   ![File > Save As](image)

   - **Save As**
     - OneDrive
     - Computer
     - Add a Place

2. Under **Save As**, indicate the location where you want to save your workbook. E.g. Desktop, folder on your computer etc.

3. To save on your computer – click on computer – Create a new folder (Ms excel 2013),

4. Type the file name

5. **Click Save**

   Your file should be saved in the folder Ms excel 2013, on your desktop.

MOVING AND COPYING DATA

Move or copy data to another worksheet or workbook

**Quick Start to MS-Excel 2013**
Moving and copying data to another worksheet or workbook is quick and easy in Excel 2013. You can move or copy all or part of the data in a worksheet to another worksheet. Copying or moving that data is used to transfer data to a worksheet in a workbook that is open in a separate instance of Excel.

- In your active worksheet, select the data that you want to move or copy.
  
  Note: Excel also copies hidden rows and columns.

- Click > the **Home tab**, in the **Clipboard group**, you can:
  
  • Move the selected data by clicking the Cut Button image.
  
  • Copy the selected data by clicking the copy button 

  Keyboard shortcut CTRL + C

To paste the data to a new location;

- Move to the worksheet or workbook you want to copy the data to

- Click > the **Home tab**, in the **Clipboard group**

  • Click on the **Paste** button

Note: Data in the paste area is usually overwritten.

Keyboard shortcut: You can also press **Ctrl+V**.

To apply different paste options, click the arrow under the **Paste** button, and then click the option that you want.

**CELL REFERENCES**
**Absolute**

Cell references in Excel are by default relative. "A cell reference is a set of coordinates that a cell occupies on a worksheet ". For example, the reference of the cell that appears at the intersection of column B and row 3 is B3 When you do not want a cell reference to change when filling cells. Unlike relative references, absolute references do not change when copied or filled.

As an example, if you want to work out the total cost generated for the quantity of shoes produced on a monthly basis, you multiply B1 * B4.

If you copy the formula = B1 * B4 from cell B5 to E5, the formula in C5 adjusts by one row and becomes =C1* C4. If you want to maintain the original cell reference in this example when you copy it, you make the cell reference absolute by preceding column B and row 1 with a dollar sign ($).

You do this by selecting B1 (since we want this value not to change) the price/pair, and press F4 on the keyboard.

Then, when you copy the formula (=B$1 * B4) from B5 to E5, the formula stays exactly the same.
Pressing **F4** allows you to switch between reference types:

<table>
<thead>
<tr>
<th>Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$B$1</td>
<td>The column and row do not change when copied</td>
</tr>
<tr>
<td>B$1</td>
<td>The row does not change when copied</td>
</tr>
<tr>
<td>$B$1</td>
<td>The column does not change when copied</td>
</tr>
</tbody>
</table>

Examples of Mixed, absolute and relative references:

A mixed cell reference is either;

- Absolute column ($B$) and relative row (1) - which is $B1
- Relative column (B) and Absolute row ($1) – which is B$1

When you add the $ sign before the column letter you create an absolute column or before the row number you create an absolute row.

**YOUR FIRST FORMULAS**

**USING THE AUTOSUM FORMULA**

It would be very useful to know the total sales for each month. This is easy as pie in Excel. Click on B7 to make it your current cell, then click on the **AutoSum** Toolbar button which can be found on the **formulas** toolbar. Your screen should look like the one below. Excel suggests the rather complicated looking =SUM (B3:B6) formula. Press the **<Enter>-key** to accept and enter this formula in B7.
You have just created your first formula. Let us analyse this astounding feat in some more detail.

- In your worksheet edit area, cell B7 displays the calculated value $236$ which is indeed the sum total of the sales for all items in January (67+69+90+10=236).

- The formula toolbar (if B7 is your current cell), displays the actual formula used to calculate the total i.e. `=SUM(B3:B6)`. The formula can be read as follows:
  - The `=` sign indicates that this is a formula, i.e. Excel has to compute something.
  - The `SUM` label indicates the nature of the formula, in this case it is a built-in function which adds the values contained in one or more cell ranges.
  - The brackets `( )` hold the argument for the function, in this case the range of values to be summed i.e. B3:B6.

- Before we pressed <Enter>, it would have been possible to change the suggested range by dragging the corners of the highlighted range (B3:B6).

- Excel provided a template of the types of arguments to be expected for the formula by means of a smart tag.

- To show the dynamic nature of Excel and its formulas, change the R67 in cell B3 to R77. Notice how the value in B7 changes automatically to reflect the new total i.e. R246. (Press <Ctrl>-<Z> or the Undo toolbar button to change the value in B3 back to R67.)

COPYING YOUR FORMULAS

We also need to calculate the totals for the other months. There are a number of different ways to do this.

The standard office way is to use the clipboard. Click B7 to make it the current cell (the source), then click the Copy toolbar button (or use the <Ctrl>-<C> shortcut key). Excel will now draw a moving dashed border around your source cell and provide...
the “Select destination and press ENTER or choose Paste” instruction in the status bar. Do so by selecting the range C7:E7 and pressing the <Enter>-key or clicking the Paste Toolbar. The selected cells will now be filled with their equivalent sum total formulas:

![Sum Formulas]

Note that the actual formula has not been copied exactly: if you check cell C7, it will show the formula =SUM(C3:C6), not =SUM(B3:B6). Excel copies the logic underlying the formula, not the exact text of the formula!

Also note the little Paste Options icon appearing next to cell E7, allowing you to select various alternative paste options by clicking on its drop-down button. These options relating mainly to which formatting you wish to use in the target cells.

To illustrate an alternative way of entering formulas, let us calculate the totals for the different items. Click cell F3, then type the following text (using the keyboard): =SUM(B3:E3) and press the <Enter>-key. If all goes well, the result $R300 should be displayed in cell F3. This illustrates that it is not necessary to use the Auto-Sum button to insert the formula, although it would have achieved the same effect.

Now, instead of using the clipboard, let us practice the second method of copying again: drag the cell handle (the little black square at the bottom right corner) for cell F3 down all the way to cell F7. The range should fill up with the appropriate SUM formulas. Notice how, with this method an AutoFill Options icon appears.

![AutoFill Options]

YOUR SECOND FORMULA

Let us build a different type of formula: let us check how our sales grow or decline each month.
To calculate the growth from one month to the next, we use the formula:

\[
\text{Growth} = \frac{\text{Current Month} - \text{Last Month}}{\text{Last Month}}
\]

This is equivalent to the formula \( \frac{\text{CurrentMonth}}{\text{LastMonth}} - 1 \). We follow:

- Click C8 to make it the current cell so we can insert the month-on-month growth for Feb. Check the status bar – it will indicate Ready.

- Type the equals sign to indicate to Excel that a formula will follow.

- We now refer to the sales total for this month by clicking on cell C7. Note how the status bar now indicates Point (i.e. we are now in cell pointing mode) and Excel fills in the cell references C7 for us.

- Now type the mathematical operator symbol for division, the forward slash key /.

- We now enter the divisor, last’s months sales, by clicking on the appropriate cell i.e. cell B7 (as shown above). Excel is still in pointing mode, so it will complete the reference B7 in the formula.

- We now complete the formula by typing -1 and pressing <Enter>.

- The formula in the formula bar should now read \( \frac{\text{C7}}{\text{B7}} - 1 \) and the result displayed in cell C8 should read \(-0.4152542\).

- The growth (or rather, decline) in sales is not really 0, but it is only a decimal fraction of the unit. Click on the Percent Style toolbar button % to format the result as a percentage. The cell should now display \(-42\%\) i.e. we had a 42% drop in sales.

- Drag or copy this cell (formula) across to the next 2 months to show a 0% growth for March and a meagre 2% growth for April. Obviously the end of the cherry season was very bad for business!

As a final test, change the March sales of bananas to R82. Does your overall sales total increase to R693 (cell F7) and your growth for March improve to 29%? If so, well-done! You have now built your first spreadsheet application.
MORE ON EXCEL FORMULAS

INTRODUCTION

Although you can use Excel just for keeping track of data in table-like structures and charting, its real power lies in the manipulation of numeric information. A critical and very important feature is Excel’s ability to let the value of one cell depend dynamically on the value of one or more other cells.

If one cell contains the price of an item and another cell the quantity ordered, a third cell is likely to automatically calculate the total amount due by multiplying the contents of the first cell with the value of the second cell. This third cell will refer to the first two cells by means of a mathematical formula (or equation). If either of the two basic values (or “independent variables”) changes, the result in the third cell is automatically and immediately updated. In order to become a competent business user of Excel, you are expected to be able to construct the formulas that are required in typical simple business spreadsheets. You have to be able to conceptualise the relationship (or dependency) between cells (e.g. how to calculate a ratio or add tax) and express these relationship in the mathematical notation required by Excel.

Note that Excel stores the formulas – also referred to as the logic of your spreadsheet – as well as the calculated values or results. By default, only the calculated result of the formula is shown on-screen (or printed). If you actually want to see the actual formula contained in a cell, you need to click on the cell and check the formula in the formula bar. (Pressing <Ctrl><`> will cause Excel to display the formulas in all cells instead of their values – this is very handy for debugging purposes. The `<` refers to the left-single-quote, not the more common `>` right-single-quote.)

SIMPLE FORMULAS AND THE ARITHMETIC OPERATORS

An Excel formula has three elements:

1. It starts with the =$character so that Excel knows that a formula expression will follow.

2. It contains constants (numbers) and/or references to other cells.

3. It contains mathematical operators and/or special functions, including brackets to indicate precedence.

The following are examples of valid Excel formulas.

Quick Start to MS-Excel 2013
• \(=\text{3*4}\)
• \(=(\text{A1+A2})/2+3\text{*A3}\)
• \(=\text{B7+2*E9-A2}\)
• \(=\text{B7*8/(EF9^A4+89.5)/(SUM(F5:H8,D9)-IF(A2>8,8,A2))-AVERAGE(F3:H6)}\)

**EXCEL’S ARITHMETIC OPERATORS**

Most formulas use the standard arithmetic operators to calculate a result based on the values contained in other cells. The following table lists the important arithmetic operators.

<table>
<thead>
<tr>
<th>OPERATOR</th>
<th>DESCRIPTION</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>=7+10+B8</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction (or negative number)</td>
<td>=10-A7</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>=A7*1.14</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>=B8/2</td>
</tr>
<tr>
<td>(^)</td>
<td>Exponentiation (To-the-power-of)</td>
<td>=A4^3 (the same as =A4<em>A4</em>A4)</td>
</tr>
</tbody>
</table>

**PRECEDENCE**

The following rules apply when Excel evaluates formulas.

- The inner-most brackets are calculated first.
- Exponentiation takes precedence over multiplication and division.
- Multiplication and division take precedence over addition and subtraction.

---

Quick Start to MS-Excel 2013
Items of equal precedence get calculated from left to right.

See if you can work out how the following examples will be calculated.

1. \(=10+5\times3-7\)  
   \(\text{result: } 10+15-7 = 18\)

2. \(=100+5\times3^{{(4-2)}/5}-20\)  
   \(\text{result: } 100+5\times9/5-20 = 100+9-20 = 89\)

If you are unsure about the exact precedence, use brackets e.g. \(=1+({81}/{3^2})\) may be the same as \(=1+81/3^2\) but the former expression leaves no uncertainty as to what is intended.

SAVING AND PRINTING YOUR SPREADSHEET

SAVING YOUR SPREADSHEET

As with any document that you create on your computer, it is important that you save your work regularly. Your computer can crash due to many reasons, including power failure, hardware troubles and operating system problems. Although Excel has an AutoSave and AutoRecovery feature (see the settings on the \textbf{File} \begin{bolden} \textbf{Options} \end{bolden} \begin{bolden} \textbf{Save} \end{bolden} menu), it does not work as well for Excel spreadsheets and you are likely to lose substantial amounts of work should a major disaster strike. In addition, you are likely to make a number of errors during the construction of your spreadsheet and some of these errors may have devastating effects.

In many cases, you can use the \textit{Undo} feature (press the \(\leftrightarrow\) button or use the \(<\text{Ctrl}><\text{Z}>\) keyboard shortcut) to recover from most errors, but this may not always work with more advanced commands. The bottom-line: save your work often!

Saving your work is done by clicking the \textbf{Save} button \(\square\), the \(<\text{Ctrl}>-<\text{S}>\) keyboard shortcut or the \textbf{File} \begin{bolden} \textbf{Save} \end{bolden} menu option. This will present the familiar \textbf{Save As} dialogue window where you can specify the folder in which you wish to save the file as well as the file name.

Make use of the various buttons e.g. to create new subfolders or change the view mode. Remember that hovering your cursor over selected items will display more detailed information e.g. hover over a file name.
to see its size and attributes. Advanced users will appreciate the Save as type: option which allows them to export spreadsheet to other applications.

PRINTING YOUR SPREADSHEET

To print your spreadsheet using the default settings, press <Ctrl>-<P> select the File ► Print and click the Print button to print out the current spreadsheet on your default printer.

To change some print defaults, press <Ctrl>-<P> or select the File ► Print… menu option to bring up the standard Print dialogue window which allows you to change the number of copies, the printer and which pages to print.

ABSOLUTE AND RELATIVE ADDRESSES

Often, you want to use similar formulas elsewhere in your spreadsheet. You can make use of the copy and paste clipboard function or, even quicker, the drag-to-copy feature whereby you drag the bottom-right corner handle of a cell or range across other cells to fill these cells with copies (or, in the event of a recognised series, the AutoFill series).

The following example will be used to illustrate the concepts.

This represents a simple invoice. The first line item has already been completed. The following formulas were used (Hint: you can see all the formulas in a spreadsheet instead of their actual values or results, by pressing <Ctrl>-`> ).

(D5) =B5*C5 Total (excluding VAT) = quantity * price
(Note: try typing “quantity*price” in cell D5 and see what happens!)

(E5) =D5*E2 VAT = total (excl. VAT) * VAT rate

(F5) =D5+E5 Total (including VAT) = Total (excl. VAT) + VAT

The next two line items will use similar formulas, so we will try replicating them.

1. Select (or highlight) the range D5 to F5 (drag the mouse cursor or press <Shift>+<cursor>-key to select with the text cursor).
2. Move the mouse cursor to the little square drag handle at the bottom right corner of the highlighted range.

3. Drag the handle down two rows to copy the formulas in row 5 to rows 6 and 7.

You should see the following:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Jean-Paul's Excel Supermarket</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Vate Rate:</td>
<td>14%</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Quantity</td>
<td>Price</td>
<td>Total (excl)</td>
</tr>
<tr>
<td>4</td>
<td>3.5</td>
<td>R</td>
<td>3.49</td>
<td>R</td>
</tr>
<tr>
<td>5</td>
<td>1.25</td>
<td>R</td>
<td>2.99</td>
<td>R</td>
</tr>
<tr>
<td>6</td>
<td>0.75</td>
<td>R</td>
<td>9.87</td>
<td>R</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The formulas in D6 and D7 seem to work ok: the total (excluding VAT) is indeed equal to the product of the previous two cells (on the same row). But the cells in E6 to F7 do not reflect the correct values. Let’s examine what went wrong. Pressing `<Ctrl>-<` > changes the view to formula view i.e. cells show the formula instead of their results (values).

Examine again the formulas in column D. When Excel copied the formula from D5 to D6, it actually changed the cell references: instead of B5*C5 the references were to B6 and C6. Excel realised that we (probably) wanted to multiply the values in the two cells on the same row and accordingly adjusted the cell references. This conserved the structure of the formula by maintaining the relative position of the cells that are referred to. Hence we call the cell references in the formula relative cell references (or addresses).

Similarly, the formulas in column F also are correct: F6 is the sum of E6 and D6 and F7 is E7 plus D7. Excel did a clever job in adjusting the relative cell references.

Now examine the formulas in column E. When Excel copied the formula from E5 to E6, it also adjusted those cell references: D5*E2 (in E5) became D6*E3 (in E6). Now, this is partially correct. The VAT in E6 must indeed be calculated on the (exclusive) total in D6. However, the VAT rate itself should still be taken from E2, not E3. We need to find a way to tell
Excel that it shouldn't change any references to cell E2. This can be achieved by fixing the reference to cell E2; we make the cell reference **absolute**. This is done by (the somewhat arbitrary convention of) placing $-signs before the cell reference: we should refer to $E2 instead of E2 in the formulas. You can test this by editing cell E5 so that the formula becomes:

(E5:) =D5*$E$2

Now drag the cell handle across E6 and F6 and the following spreadsheet appears:

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Price</th>
<th>Total (excl)</th>
<th>VAT</th>
<th>Total (incl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apples</td>
<td>3.5</td>
<td>3.49</td>
<td>=B5*C5</td>
<td>=D5*$E$2</td>
<td>=D5+E5</td>
</tr>
<tr>
<td>Bananas</td>
<td>1.25</td>
<td>2.99</td>
<td>=B6*C6</td>
<td>=D6*$E$2</td>
<td>=D6+E6</td>
</tr>
<tr>
<td>Cherries</td>
<td>0.75</td>
<td>9.87</td>
<td>=B7*C7</td>
<td>=D7*$E$2</td>
<td>=D7+E7</td>
</tr>
<tr>
<td><strong>Total:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You will note that Excel changed the **relative** cell reference D5 to D6 and D7 respectively, but did not touch the **absolute** reference to $E2. Press `<Ctrl>`-`>` to change back to the normal view and you will see the correct values as follows. (We have also added the totals in row 8 by making use of the **AutoSum** button).

The distinction between absolute and relative references is initially a fairly difficult concept to grasp but it is essential to building anything beyond the most basic spreadsheets.

Whenever you are entering or editing a formula, you can convert a relative cell address into and absolute reference by pressing the `<F4>` function key.
INSERTING AND DELETING ROWS/COLUMNS

Although you should plan your spreadsheet carefully before you start developing it, it often happens that you want to insert an additional row or column of data in your spreadsheet.

INSERTING A NEW ROW

Assume that you built your spreadsheet as shown and realize that you have forgotten to enter the sales for Avocados. You want to insert a new row number 4 for the avocados and move all the other rows from “Bananas” onwards down one row. There are two alternative methods for inserting the required row.

1. Right-click on the row number 4 to bring up the menu and select the Insert option. This will move row 4 and all the others below one row downwards and insert a new row.

2. Right-click any cell in row 4 and select the Insert… option from the right-click menu. The Insert window will pop up allowing you to shift selected cells or insert a row or column. Click the Entire row option to insert a row.

When you insert a row (or column), all formula references to cell in rows that have moved down (or right) are automatically adjusted. Where formulas contain references to cell ranges, these references will be adjusted as long as the row falls within range. In the example above, cell B7 contained the formula =SUM(B3:B6) before the row insert; this calculates the total sales of 4 products. After a row has been inserted, cell B8 will now contain the formula =SUM(B3:B7) i.e. this calculates the total for all 5 products. If you had instead inserted a row at row 7 i.e. where the sales total were calculated, the =SUM formula would not have been updated i.e. cell B8 would still (and erroneously) contain the formula =SUM(B3:B6).

Any of the three possible methods of inserting a row also allows you to insert multiple rows at once by selecting a range of rows or cells prior to selecting the Insert Row command.
INSERTING A COLUMN

To insert a column, you can make use of exactly the same two methods.

When using the first method, right-click a column name (e.g. “D”) instead of a row number and choose the **Insert** option. When using the second method, **Entire column** option on the popup window. In both case, the column in which the cell is currently located will be shifted to the right.

DELETING COLUMNS OR ROWS

You will have noticed that all of the above menus also feature an option to **Delete** rows or columns.

Be very careful when deleting rows or columns that contain data. Not only can you loose valuable data but remember that any formula which references the deleted cells will now give the error message: “#REF!”. This means that the formula contains an invalid cell reference.

The example on the left shows what happens should you mistakenly delete columns B to E in the above examples, causing the range reference in the formula

\[ =\text{SUM(B3:E3)} \]

to become meaningless.

Should this happen, you can use the **Undo** button to restore the deleted columns.

SOME BASIC BUSINESS FORMULAS

Some calculations keep recurring, no matter what type of business spreadsheet applications you develop. It is important, therefore, that you are familiar with some of the more common business calculations.

CONVERTING A NUMBER TO A PERCENTAGE OR VICE VERSA

One of the most confusing issues confronting novice Excel users is how Excel treats percentages. Forget all you have learnt at school on how to express percentage using paper

**Quick Start to MS-Excel 2013**
and ignore completely the way the % key works on a calculator. The rule is simple: there is no need to multiply or divide figures by 100 in order to obtain a percentage. In Excel, a growth rate of +12% is exactly the same value as a growth rate of +0.12. The only difference is in the formatting: using the % format will automatically display the value, multiplied by 100 and followed by the % symbol.

If you want to enter a value (constant) you can type either, say 8% or 0.08.

The formulas =A4*14% or =A4*.14 or =A4*0.14 are entirely equivalent.

Practice this for yourself by entering 0.345 in a cell and formatting it as a percentage (should say 34.50%) or entering a percentage, say -76.54%, and formatting it as a, say fixed format.

E.g. click the Comma Style button on the formatting toolbar to display -0.77, then click the Increase Decimal button once or twice to increase the number of decimals so you can see that the real value is indeed -0.7654.

ADDING A PERCENTAGE

There are many situations where you need to add a percentage to a base value, e.g. when adding a growth rate, markup or VAT.

The formulas are simple:

• The growth amount (or addition) will be calculated as =BASE * GROWTH%

• The new total will be calculated as =BASE + GROWTH AMOUNT

Sometimes, you want to calculate the new total in one single step, without first having to calculate the growth amount. Calculate the final value/new total in one go as

= BASE * (1 + GROWTH%)  OR  = BASE + BASE * GROWTH%

Check out the formulas for the examples below. Column C displays the formulas used in column B in text form, with spaces added for readability.
DEDUCTING A PERCENTAGE OR DISCOUNT

To deduct a percentage from an amount, or give a discount, you can use the same formulas as for adding except that you use a “-” instead of a “+”.

CALCULATING A FRACTION OR PERCENTAGE

Often, a number needs to be expressed as a fraction or percentage of another number. This is achieved simply by dividing the number into the other number.

A typical example is to express the sales of, say, a region or product line as a fraction of total sales, e.g. if the sales of non-perishables equal R 382 (million) and the total sales are R 970 (million), then non-perishables are R 382 / R 970 = 0.393814… of the total, or 0.39 when rounded to the nearest hundredth.

Where these fractions represent a portion of a total, a percentage is more commonly used. In Excel, all you have to do is to format the cell containing the formula as a percentage format. In the above example, the number 0.393814 will be displayed as 39% (or possibly, with more precision, as 39.38%). The same formula is used but a different (presentation) format is applied! (Note: if you want to represent this as a real but approximate fraction, Excel also provides a Fraction format which would display this as (being approximately) 2/5th (two-fifths) – see cell formatting later.)
Note that fractions do not have to be less than 1 (or 100%) e.g. if the population of a large city is 3.5 million and the population of a smaller town is 240 thousand then the city’s population is $3\,500\,000 / 240\,000 = 14.58$ times that of the smaller town.

FINDING A GROWTH RATE OR MARKUP PERCENTAGE.

A problem similar to that above is where an unknown percentage has been added to (or deducted from) an amount but the total is known. Typical examples are to calculate year-on-year growth percentage given the two annual figures, or to figure out the discount given or tax added given the gross and net amounts.

Calculate the growth rate (or markup) by means of the following formula:

$$\text{Growth Rate} = \frac{\text{New} - \text{Base}}{\text{Base}}$$

The logic behind this formula is that it first calculates the growth as an amount ($\text{New} - \text{Base}$), and then to expresses this growth as a fraction of the original base.

An equivalent formula which does not require you to reference the Base value twice is:

$$\text{Growth Rate} = \frac{\text{New}}{\text{Base}} - 1$$

E.g. if last year’s sales were R450 million and this year’s sales are R520 million then the growth rate is: $= (520 - 450) / 450 = 70 / 450 = 0.15555\ldots$ (or 15.56%). A more efficient though slightly less intuitive way is to use the second formula $= (\frac{520}{450}) - 1 = 1.15555 - 1 = 0.15555$, since you would only enter each cell reference once. Note that the brackets are not strictly necessary for the second formula, since Excel gives a higher priority to multiplication/division than to addition/subtraction.

A markup percentage is calculated in the same manner. So are a decline or discount rate, except that the formula will yield a negative value since the New value is less than the Base value.

APPLYING AN ANNUAL INTEREST FOR A MONTH

Interest rates are usually expressed as an annual interest rate but calculated on a more frequent basis e.g. monthly. For example, the interest rate on your savings account might be quoted as 9% (per annum) but the bank may calculate (and give you) interest each month on...
the outstanding balance. In this case, you can calculate the interest due to you by dividing the annual percentage by 12 (months) i.e. \( 9\% \div 12 = 0.75\% \). Multiply the equivalent monthly interest rate with your balance to find the interest accrued. E.g. if your balance at the beginning of the month was R 14 500, then you will have earned \( R 14 500 \times (9\% \div 12) = R 108.75 \).

### Compound Interest

A slightly more advanced but still fairly common financial calculation is where a single initial amount is invested and interest then accrues to the investment account on a regular basis. What happens is that the investment amount grows each period due to the interest which is added, which causes subsequent interest payments to increase since the balance increases each period. In effect, interest is earned on earlier interest. This is known as **compound interest**.

The example on the left illustrates this using an initial investment of R 10 000 and a monthly interest rate of 1% (equivalent 12% annualised interest rate).

There exists a somewhat complicated formula which calculates your final balance using one single calculation, instead of having to build the entire table of monthly interest calculations.

\[
\text{Final Balance} = \text{Initial Balance} \times (1 + \text{Interest Rate})^{\text{Number of Periods}}
\]

Note that the “^” symbol is Excel’s notation for a power function e.g. \( 3^2 \) (i.e. the square of 3) is expressed as =3^2 in an Excel formula. The number of periods (e.g. months, days, semesters, etc.) refers to how many times interest has to be calculated and the interest rate is the actual interest percentage earned (or charged) per single period. What really happens in the formula is that the power function is shorthand for all the required multiplications.

In the above example, you could use the formula =B2*1.01^12 (with B2 the cell containing the initial balance i.e. R10 000, and 1.01 equivalent to \( 1 + 1\% \)) to calculate the final December month-end balance directly.

### Exercises

**Exercise 1**

<table>
<thead>
<tr>
<th>Month</th>
<th>Initial Balance</th>
<th>Interest</th>
<th>Month-end Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>R 10 000.00</td>
<td>R 100.00</td>
<td>R 10 100.00</td>
</tr>
<tr>
<td>Feb</td>
<td>R 10 100.00</td>
<td>R 101.00</td>
<td>R 10 201.00</td>
</tr>
<tr>
<td>Mar</td>
<td>R 10 201.00</td>
<td>R 102.01</td>
<td>R 10 303.01</td>
</tr>
<tr>
<td>Apr</td>
<td>R 10 303.01</td>
<td>R 103.03</td>
<td>R 10 406.04</td>
</tr>
<tr>
<td>May</td>
<td>R 10 406.04</td>
<td>R 104.06</td>
<td>R 10 510.10</td>
</tr>
<tr>
<td>Jun</td>
<td>R 10 510.10</td>
<td>R 105.10</td>
<td>R 10 615.20</td>
</tr>
<tr>
<td>Jul</td>
<td>R 10 615.20</td>
<td>R 106.15</td>
<td>R 10 721.35</td>
</tr>
<tr>
<td>Aug</td>
<td>R 10 721.35</td>
<td>R 107.21</td>
<td>R 10 828.57</td>
</tr>
<tr>
<td>Sep</td>
<td>R 10 828.57</td>
<td>R 108.29</td>
<td>R 10 936.85</td>
</tr>
<tr>
<td>Oct</td>
<td>R 10 936.85</td>
<td>R 109.37</td>
<td>R 11 045.22</td>
</tr>
<tr>
<td>Nov</td>
<td>R 11 045.22</td>
<td>R 110.46</td>
<td>R 11 155.68</td>
</tr>
<tr>
<td>Dec</td>
<td>R 11 156.66</td>
<td>R 111.57</td>
<td>R 11 268.25</td>
</tr>
</tbody>
</table>

Quick Start to MS-Excel 2013
Your friend Thabo just opened his movie rental shop in Butterworth – Eastern Cape. He wants to keep electronic records of movie collections in his shop.

Thabo has therefore requested you to create a simple spreadsheet for his music store to record details of all customers, all the movies in the store and the suppliers. The file is also used to manage sales i.e. records of who has bought which album.

- Insert the heading **Movie Information** in Cell A1
  
  Font type: Calibri  
  Font size: 18  
  Bold, Text align: Left  
  Font colour: Blue  
  Background: grey

- Add the following the headings :
  
  Cell B2: should read **Year**
  Cell D2: should read **REVIEW**
  Cell F2: should read **GENRE**
  Cell H2: should read **RATING**
  Cell I2: should read **STARRING ACTORS.** Wrap the text so that it fits into this cell.

- Add all borders to cells A1: I6; thick borders to cells A1:I2
- Insert a comment in Cell A1 stating: This is an album spread sheet

Once you have completed entering the text, ensure that your formatting is correct, column widths allow all data to be displayed headings borders as displayed.

Your final Spread sheet should look as follows

---

Quick Start to MS-Excel 2013
Thabo’s business has branches all over the country and he decided to use MS Excel to manage most of the company’s information. Thabo the manager wants to start by managing his employees before embarking on the products, store and customer information. The manager approaches you with the preliminary data as shown in his excel spread sheet.

- Save the file in your F-Drive as Exercise 2
- Rename sheet4 to Employees
- Add a new row just before the column headings.

Quick Start to MS-Excel 2013
• Merge columns A1:J1 in row 1

• Enter the following as text for the merged row: Employee Details
  
  o Change the font size to 14  o Bold the text  o
  
  Change the background to Tan (greyish colour)  o
  
  Change the font style to Bookman Old Style

• Cell I18 should read Total payable wage amount.

• Use flash fill to enter the First Name and Last Name in the respective columns e.g. Last name: Amier First name : Aneesah

• Apply the “table style medium 9” formatting for cell A1:K15

• Your Friend Thabo wants you to compile weekly wages for his employees based on the hours worked.

• Thabo uses a flat rate of 100/hour to pay his employees.

• In cell K3:K16 calculate the weekly wage for these employees.

  • Wage is calculated by multiplying number of hours (J) by Flat rate /hour (B19)

  • Format cell range K3:K16 to display Rand Currency figures to 2 decimal point.

  • Calculate the total wage amount in cell K18

  • Use a formula to calculate the lowest wage in Cell K19

  • Use a formula to calculate the highest wage in cell K20
Build the spreadsheet model displayed below. Try to build the spreadsheet example exactly as shown, including structure, cell alignment, formatting of values, borders, column widths etc. Use the copy/paste function where possible (i.e. use absolute/relative addressing where appropriate). It is more important to get the formulas correct than to get the exact formatting! TeleTubbies Imports are South African importers for TeleTubby dolls from the UK. You are to build a simple spreadsheet that forecasts their income for the year ahead on a quarterly basis. Note that their purchases are sourced from the UK and paid for in £ (and need to be converted to Rand) but their sales are in SA Rand.

- Rows 2 to 4 contain the main variables. (Note: B2 contains the value 4.85, formatted as a £ currency. Don’t waste valuable time on getting the £ symbol right!)

- Column A contains the income/cost descriptions, columns B-E the data for the four quarters, column F the total for the year and column G the percentage change from the first to the fourth quarter (as detailed below).

- Row 6 contains the projected order/sales quantity (in units). These figures are based on market research and current orders.

- Row 7 contains projected sales revenue, calculated as quantity (row 6) times local selling price (B3)

- Row 8 contains the £/R exchange rate. The expected exchange rate for the first quarter is R10.31 per £ and this is expected to increase at a quarterly rate of 2% (see F2).

- Row 9 reflect the purchase cost of the TeleTubbies, expressed in £, based on the quantity bought (row 6) and the contracted purchase price per unit (B2).

- Row 10 is the revenue in Rand, based on the projected exchange rate for the quarter (in row 8) and the purchase cost (in £).
• Row 11 calculates the import duty due on the TeleTubbies. This is the sum of an advalorum (i.e. value-based) duty equal to 10% (B4) on the cost of the TeleTubbies, and an additional fixed import charge of R2 per item (F4).

• The marketing costs are R35,000 initially, but decrease by R5,000 per quarter (F3).

• The Total Costs are the sum of the purchase cost, import duty and marketing cost.

• Net income is calculated as the difference between sales revenue (row 7) and the total costs (row 13).

• Column G expresses how the different components (and the net income) change (as a percentage) from the first to the fourth quarter. The change is the difference between the two quarters, expressed as a percentage of the base (1st quarter).

• Cell G1 should always reflect the current date (ignore the data given on the example).

Once you have completed entering the text, values and formula in the model you will gain additional marks by ensuring that your formatting is correct, column widths allow all data to be displayed, numbers are displayed to the correct number of decimal places and headings and totals have borders as displayed.

• If the selling price would be increased to R99.99 per item how much would Net Income (in Rand) be for 3rd Quarter (D14)? How much would the Total (Annual) Net Income (F14) increase by when compare to the current Total Net Income of R 123 850? Express this increase as a percentage.

• With a Selling Price of R99.99, how much should the import price increase by so that our Total Annual Net Income (F15) will be equal to R 140 000? Give the Import Price (B2) to the nearest £0.05.

Save the file under the name TUBBY.
The following table gives an overview of functions that are often very useful in business contexts. Although the list may look a little intimidating, remember that Excel functions are like new words: if you have used them once or twice in the right context, you’re unlikely to forget them (at least until old age brings on senility).

Note that where functions require values, you can substitute cell references or even other functions – we call that nested formulas. They can get very complex very quickly. A range (e.g. A1:B9) is sometimes referred to as an array (or, if it’s only one column or row, a vector).

<table>
<thead>
<tr>
<th>BASIC FUNCTIONS</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=SUM(range)</td>
<td>SUM calculates the total of (i.e. adds) all values in the range e.g. SUM(A1:B10). You can also give a list of ranges and/or values e.g. SUM(A1:C9,-D4,100).</td>
</tr>
<tr>
<td>=PRODUCT(range)</td>
<td>PRODUCT calculates the product of the arguments given. SUMPRODUCT adds the products of each corresponding term in the ranges together. Useful for calculating weighted averages e.g. SUMPRODUCT(A1:K1,A2:K2) calculates the weighted total of the values in row 2 weighted with the values in row 1. {Advanced hint: You would normally use an absolute reference to the range of weights (A$1:K$1) so that you can copy the formula down.}</td>
</tr>
<tr>
<td>=SUMIF(range, condition)</td>
<td>Sum total of all values in the range that meet the specified logical condition e.g. SUM(A1:B10,“&gt;10”) adds only those values together that are larger than 10</td>
</tr>
<tr>
<td>=COUNT(range)</td>
<td>Counts the number of numerical values in the range i.e. it doesn’t include empty cells or cell containing labels (text). Use =COUNTA(range) if you also want to include text values (i.e. counts the number of non-empty cells in the range)</td>
</tr>
<tr>
<td>=COUNTIF(range, condition)</td>
<td>Counts the number of numbers in the given range that meet the specified condition e.g. COUNTIF(A1:B9,”&lt;0”) counts the number of negative values or COUNTIF(A1:B9,C2) counts the number of values in A1:B9 that are equal to C2</td>
</tr>
<tr>
<td>Formula</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>=AVERAGE(range)</code></td>
<td>The arithmetic average of all numerical values in the range. Equal to <code>SUM(range)/COUNT(range)</code>. Use <code>=MEDIAN(range)</code> to find the median i.e. middle value and <code>=MODE(range)</code> to find the mode i.e. value which occurs most often.</td>
</tr>
<tr>
<td><code>=MEDIAN(range)</code></td>
<td></td>
</tr>
<tr>
<td><code>=MODE(range)</code></td>
<td></td>
</tr>
<tr>
<td><code>=MAX(range)</code></td>
<td>Find the highest/largest (MAX) or lowest (MIN) value in the range.</td>
</tr>
<tr>
<td><code>=MIN(range)</code></td>
<td>Use LARGE if you want to find the n-th largest value e.g. <code>LARGE(A1:B9,3)</code> returns the 3rd largest value and <code>SMALL(A1:B9,2)</code> returns the one-but-smallest (2nd smallest) number. Note that <code>LARGE(range,COUNT(range))=MIN(range)</code> ☺</td>
</tr>
<tr>
<td><code>=LARGE(range,n)</code></td>
<td></td>
</tr>
<tr>
<td><code>=SMALL(range,n)</code></td>
<td></td>
</tr>
<tr>
<td><code>=RANDBETWEEN(low,high)</code></td>
<td>RAND has nothing to do with the South African currency unit but generates a random number between 0 and 1 each time the spreadsheet is recalculated. <code>RANDBETWEEN</code> generate integer random numbers between low and high. Try to guess the interesting thing that happens when you type in <code>=RAND()</code> in a blank MS-Word 2013 document and press enter.</td>
</tr>
<tr>
<td><code>=RAND()</code></td>
<td></td>
</tr>
<tr>
<td><code>=MOD(value,modulus)</code></td>
<td>Calculates the remainder when value is divided by modulus e.g. <code>MOD(8,3)</code> is 2 because when 8 is divided by 3 the remainder is 2.</td>
</tr>
<tr>
<td><code>=INT(value)</code></td>
<td>INT removes the decimal part of a positive number e.g. <code>INT(3.7)</code> is 3. (It actually returns the integer smaller or equal to the number e.g. <code>INT(-3.7)</code> is -4!). <code>ROUND</code> rounds the value to the nearest number with n decimal places e.g. <code>ROUND(3.777,0)</code> is 4, <code>ROUND(3.777,2)</code> is 3.78 (useful for rounding to the nearest cent) and <code>ROUND(17426,-3)</code> is 17000 (i.e. round to the nearest 1000 or 3 digits to the left of the decimal). Related functions are CEILING, FLOOR, ROUNDUP and ROUNDDOWN. <code>MROUND</code> allows you to round a number to the nearest multiple e.g. <code>MROUND(3.772,0.05)</code> rounds to the nearest 5 cents (i.e. 3.75)</td>
</tr>
<tr>
<td><code>=ROUND(value,n)</code></td>
<td></td>
</tr>
</tbody>
</table>

**LOGICAL/CONDITIONAL FUNCTIONS**
<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=IF(condition, value if true, value if false)</td>
<td>Check if a condition holds and, if so, returns the true value, else it returns the false value. E.g. IF(A1&lt;0,0,B1<em>A1) will return 0 if A1 is negative and B1</em>A1 if not. IF(A1&gt;10,”Hello”,“”) will return “Hello” if A1 exceeds 10 else you’ll have an empty cell/value.</td>
</tr>
<tr>
<td>=IFERROR(cell reference, value if error)</td>
<td>Checks to see if the cell referenced contains an #ERROR. Useful to stop error values from propagating e.g. IFERROR(A1,0) returns 0 if A1 contains a #DIV/0! Error (a number divided by 0). The =IFNA does the same but checks if the cell contains an #NA value.</td>
</tr>
<tr>
<td>=OR(list of conditions)</td>
<td>This functions return TRUE or FALSE and are usually used inside IF statements (including SUMIF, COUNTIF etc.). OR checks if any of the conditions is true, AND checks if all of the conditions are true and NOT returns the opposite of the condition. These are usually used inside a more compli-</td>
</tr>
<tr>
<td>=AND(list of conditions)</td>
<td>cated IF function E.g. OR(A1&lt;0,A1&gt;10,A1=5) will be true if (whether) A1 is negative, larger than 10 or equal to 5. AND(A1&gt;0,A1&lt;10) will be true for values of A1 between 0 and 10 (useful for checking if a value falls inside an interval). NOT(A1=5) checks that A1 is not equal to 5 (can also be written as A1&lt;&gt;5). E.g. IF(AND(A1&gt;0,A1&lt;10,A1&lt;&gt;5),”Yes”, ”No”) will return Yes if A1 falls between 0 and 10 but isn’t equal to 5.</td>
</tr>
</tbody>
</table>

**FINANCIAL FUNCTIONS**

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=PMT(RATE,NPER,PV,[FV],[TYPE])</td>
<td>Calculates any one of the missing parameters if an investment or loan with an initial capital payment of PV (Present Value) is paid over an NPER number of periods at an interest rate of RATE using a fixed instalment (payment) of PMT. You can specify an optional balloon payment FV (Future Value) at the end of the loan/investment. The TYPE indicates whether payments are made at the beginning or end (default) of each period. E.g. -PMT(12%/12,20*12,1500000) calculates the monthly payment on a house loan of R1,500,000 over 20 years at an (annual) interest rate of 12%. If you save R1000 (at the end of) every year from the age 21 till age 65 and you can earn 4.5% p.a. tax free, you will retire with a capital of FV(0.045,65-21,1000). Note that the sign of PMT is usually opposite to that of PV (or FV).</td>
</tr>
<tr>
<td>=PV(RATE,NPER,PMT,[FV],[TYPE])</td>
<td></td>
</tr>
<tr>
<td>=FV(RATE,NPER,PMT,PV,[TYPE])</td>
<td></td>
</tr>
<tr>
<td>=NPER(RATE,PMT,PV,[FV],[TYPE])</td>
<td></td>
</tr>
<tr>
<td>=RATE(NPER,PMT,PV,[FV],[TYPE])</td>
<td></td>
</tr>
<tr>
<td>Formula</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>=IRR(range)</td>
<td>Calculates the internal rate of return of the cash flow series given in the range. The first cell in the range contains the initial investment/loan (time = 0) and is usually of an opposite sign of (most of) the other cash flows.</td>
</tr>
</tbody>
</table>

**TEXT FUNCTIONS**

Unlike most of the other Excel functions, these functions allow you to manipulate text (strings) instead of numbers.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=LEN(string)</td>
<td>Calculates how many characters there are in the string e.g. LEN(“Hello”) is 5.</td>
</tr>
<tr>
<td>=FIND(text,string,[startpos])</td>
<td>Returns where in the string a specified text (substring) is found e.g. FIND(“ll”, “hello”) is 3. You can specify an optional starting position from where to start searching e.g. SEARCH(“l”, “hellollo”) is 6.</td>
</tr>
<tr>
<td>=SEARCH(text,string,[startpos])</td>
<td></td>
</tr>
<tr>
<td>=MID(string,start,nrchars)</td>
<td>Gives a substring from string of nrchars long and starting from the specified position. MID(“hello world”, 7, 3) is “wor”. LEFT returns the leftmost nrchars of the string.</td>
</tr>
<tr>
<td>=LEFT(string,nrchars)</td>
<td></td>
</tr>
<tr>
<td>=TEXT(value,format)</td>
<td>TEXT turns a numeric value into a text string e.g. TEXT(3.14,”#.#”) creates the string (label) “3.1”. Value attempts to create a numeric value from a string that looks like a number.</td>
</tr>
<tr>
<td>=VALUE(text)</td>
<td></td>
</tr>
<tr>
<td>=CONCATENATE(list of strings)</td>
<td>Joins the strings together. It is the same as using the &amp; but can be use in, e.g. array and nested functions. CONCATENATE(A1,B2,”?”) is the same as A1&amp;B2&amp;”?”</td>
</tr>
</tbody>
</table>

**DATES AND TIMES**

Excel uses values to represent dates and times on a timeline. The integer part of the value indicates the number of days since 1-Jan-1900. The fractional part the time of the day. E.g. 3.25 refers to the 3rd January 1900 (day #3) at 06:00 AM (0.25th of the day). 41849.458333 corresponds to 29 July 2014 (the 41849th day since 1 Jan 1900) at 11:00 (11/24th of the day). Formatting these numbers using DATE and TIME or CUSTOM number formats make them appear as dates but you can do calculations with them like you would with numbers e.g. subtracting on date from another gives the number of days (and time) between them (if you re-format the result using a FIXED number format). Adding 7.5 to a date (e.g. NOW()) takes you one week (7 days) and 12 hours (0.5 dyas) further.
=DATE(year,month,day) Calculates the “date” value corresponding to the specified date (the number of days from 1 Jan 1900 to the date). E.g. DATE(2014,7,29) equals 41849. DATEVALUE does the same thing except that you can specify the date in a string (text) that looks like a date e.g. DATEVALUE("29-Jul2014"). (Note: TIME and TIMEVALUE will do the same for times e.g. TIMEVALUE("3:15:00")

=TODAY() TODAY will calculate the date value for today (gives an integer value). NOW will also calculate the current time (i.e. adds a fractional part of the date value), given your local PC time.

=NOW() Returns the current date and time.

=YEAR(datevalue) These functions return the given year (2014), month (1-12) or day of the month for a date value. The fractional part can be converted to hours (023), minutes within the hour (0-59) or seconds within the minute (0-59) with the correspondingly named functions.

=MONTH(datevalue)
=DAY(datevalue)
=HOUR(datevalue)
=MINSUTE(datevalue)
=SECOND(datevalue)

LOOKUP FUNCTIONS

These scary-looking functions are complex the first time you use them, but they are amazingly useful and, once understood, become almost second nature to the experienced Excel user.

=VLOOKUP(value,table,col#,type) VLOOKUP will locate the value in the first column of the table
| Formula: \[=HLOOKUP(value, table, row#, type)\] | (specified as a range) and return the value in col#-nth column of the (same) row where the value was found. If type = FALSE or 0, then an exact match for the value must be found (in the first column) but the table doesn’t have to be sorted in any particular order (e.g. looking up a student number, order number or product code). If no exact match is found, an error value is returned. If the type = TRUE or omitted, then the closest lower match is used but it is assumed that the table is sorted from low to high (e.g. looking up a marginal tax rate in a table containing the income brackets, or a student grade in a table with cut-off mark boundaries). This always returns a match.

HLOOKUP does a similar thing but it looks for the value in the first (top) row and, when found, returns the corresponding value (i.e. in the matching column) from the n-th (row#) row. |